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GradePlane for Windows 

 

 

GradePlane is designed for Land Levelers and farmers and provides an easy way to design 

and output cut/fill maps for grading land to specified slopes.  It uses the common, plane method 

of field design and expects you to enter surveyed Elevation or Rod Readings into a spreadsheet 

type Grid.  Once data is surveyed and entered, GradePlane calculates the field “best fit” 

slopes and creates a field design automatically based on the best fit.  It does this “on the fly” as 

you are entering field data. As soon as you have field data entered, your best fit design is done. Of 

course, you can fine tune the design any way you want, changing row and column slopes, 

importing and exporting yardage, create sections and break lines, and engineer smooth transitions 

at breaks. The standard version allows fields to be designed in up to seven Sectors and can 

engineer smooth transitions at sector breaks in either the column or row direction.  With the 

standard version you can also monitor the progress of your work as you cut the field and check 

the design to insure your field will balance. The standard version also includes 3 D graphs of your 

field data and designs which makes field layout easier to visualize. 

 

While GradePlane is easy to use, it is assumed you know how to use a personal computer and 

Windows software, and you know about Land Grading and designing fields for irrigation. All 

calculations in GradePlane are estimates based on survey data that you provide. If your survey is 

incorrect to begin with, then all results and designs estimate will also be incorrect.  Also, 

recognize that GradePlane makes yardage calculations based on the assumption that you grade 

the field as you specified in your design. If you don‟t cut the field to the specified slopes or if you 

don‟t properly setup or calibrate your landgrading equipment then your results may not be those 

listed on your Cutsheet. GradePlane makes the design calculation process easier and faster, but 

you are the ultimate field designer. Make sure the designed output is what you would normally 

expect to see and if not, check your data to make sure all is correctly entered. And, of course, a 

Cutsheet is only a small part of the process. It takes a skilled land grader to turn the  design into a 

graded field.  You need keep a close eye as grading progresses to insure you are grading the field 

as you designed it and your assumptions are valid. 

 

 

 

 

 

 

 



 - 2 - 

 

 

 
 

Field Survey 
 

 GradePlane  requires data to be surveyed on a square grid.  The field doesn‟t have to be 

exactly square, but the survey must be based on regularly spaced grid intervals, rather than 

randomly surveyed data points.  The standard is 100 feet between stations (which is the default), 

but you are free to specify other grid intervals if you prefer.  In all cases, the first grid line of your 

survey should begin about one-half the grid interval from the edge of the field.  You then lay out 

your survey grid by drawing 

perpendicular lines spaced at the 

grid interval in both the Row and 

Column directions.  In GradePlane 

Columns are Up and Down on the 

page and represented by Letters and 

Rows are Left to Right on the page 

and represented by numbers.   

 

 

When surveying, you record either 

rod readings or elevations at each 

grid intersection.  This reading 

becomes the representative elevation 

of the entire 100 feet square station, 

so make sure the location is really 

representative of the entire section, 

if not, move location slightly before 

recording the reading. 
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 GradePlane allows you designate any grid location as a partial station (versions 1.50 and 

above)  For fields that are not a perfect rectangle partial stations allow you to better estimate cut 

and fill yardage.  You may designate a partial 

station to be 5 % to 150 % of a normal sized 

station.  Gradeplane will adjust field areas and 

yardages accordingly.  For example, if your 

regular grid size is 100 feet by 100 feet, 

designating a partial station size as 50% would 

reduce the area used from 10,000 square feet 

to 5,000 square feet.  You designate a partial 

station by highlighting, one or more stations 

using the mouse, then  Right-Click the mouse 

on the highlighted cells and choose set partial 

station.  Enter the partial station value.  You 

can also access the partial station option for 

the Design Main Menu section.  Partial 

stations will be marked with a small red triangle in the upper right hand corner of the spreadsheet 

to indicate the station grid size is not 100%. Click on [-Reset-] to return the cell to 100% 

 

 

You can design fields using feet, acres and Cubic Yards, or meters, hectares and cubic meters. 

 

Default Design Values 
 

The default values for GradePlane are: 

 

Data Type: Elevations 

Units:  Feet/Yards/Acres   

Grid Size: 100 feet by 100 feet 

Cut/Fill Ratio: 1.25  

 

You may change any of the above values by selecting:  Options, Preferences from the Main 

Menu.  The values you enter become the new default values until you again change any of the 

values.  These values will be stored with any Field data saved. 

 

 

 

 

Slopes 
 

In GradePlane, increasing 

slopes (rise) are positive numbers 

and falling slopes (fall) are 

negative numbers referenced to the 

upper left hand corner of the 

spreadsheet (Cell A1). Rows are 

left to right and identified with 

numbers Columns are top to 

bottom and identified with letters.   

 

+ .10

- .10

+ Rise, - Fall
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If you specify a 0.10 Row slope, then slopes along the rows increase in slope 0.10 feet per 100 

feet, left to right, from Column A to M.  If you specify a - 0.10 Column slope, slope down the 

columns decrease in slope 0.10 feet per 100 feet, top to bottom, from Row 1 to Row 10.  On  

the printed Cutsheet, map arrows will print showing the direction of fall.  Do note that slopes are 

specified per 100 feet (or % slope) regardless of the grid size. If your grid size is not 100 feet 

then your slopes will be adjusted accordingly when display on the spreadsheets.    For example, 

with 50 a ft grid size, a specified 0.10 Row slope would be 0.05 per 50 feet (the grid size). 

 

 

 

Although most land graders talk in terms of Row slope and Cross slopes, in reality, the field plane 

also slopes in one direction at a particular slope and angle from a specified reference point.. This 

value is the normally referred to as the compound slope.  Even though you enter row and column 

slopes, GradePlane also calculates the compound slope for use in setting up single slope lasers.  

To use compound slope you, normally, set your laser to the specified compound slope value, 

point the laser in the direction of the larger slope, then rotate (or turn) the specified angle in the 

direction of the smaller slope and set the compound slope value.  However, follow your laser 

manufacturer‟s guidelines for setting compound slope. 



 - 5 - 

 

 

Elevations and Rod Readings 
 

Standard field surveying methods normally use some type of transit or optical level along with a 

survey rod.  A survey rod usually denotes zero at the bottom and increases in tenths of foot up to 

seven or eight feet tall.  Using a survey rod results in “rod readings” that are inversely 

proportional to field elevations.  (The lower the rod reading, the higher the elevation.)  These rod 

readings can be converted to elevations.  GradePlane accepts either Rod Readings or Elevations 

and converts between the two types of data using a real or arbitrary bench mark or instrument 

height.  Recognize that increasing readings along a row or column indicate a fall when using rod 

readings, and a rise when using elevations.  However, GradePlane always indicates slopes the 

same: negative numbers indicate a fall from left to right on the grid (or top to bottom) and 

positive numbers indicate a rise. Normally you should always survey in and use Elevations, 

unless you either already have a field surveyed in Rod Readings or you have a preference for Rod 

Readings.  You must specify the correct data type BEFORE entering survey readings into 

Gradeplane. If you do specify the field data to be in Elevations, but you really entered the data in 

Rod Readings  (or vice versa) then simply specify the data correctly under the Preferences menu 

AFTER entering all the data.  If you somehow get half the data in rod readings and half in 

elevations you will have to start over.  

 

 

Elevation Data Input Directly into GradePlane from a Laser Receiver. 
 

If your Laser receiver control unit/box can output standard computer RS232 serial data, you may 

be able to directly read your survey data into the GradePlane spreadsheet grid from a Laser 
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Control Box connected to a Laptop computer serial port.  Check with your equipment 

manufacturer for the proper serial cable to connect between the control box and your laptop. 

 

Connect your Laptop serial port to the Laser Mast control box with a serial cable as specified by 

the control box manufacturer. 

 

Start GradePlane and Select Survey with Laser Mast from the Options Menu. 

 

 
 

 

 

You'll then see the Laser Mast Panel appear.  It shows several buttons and a read out display for 

the elevation values: 

 

 

 

 

 

 

 

 

Next, click on the Setup Button to setup the serial port parameters.  You will see the following 

Dialog: 
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From the serial port setup, select your control box type/manufacturer, which will establish default 

values for your equipment.  If your serial port parameters are different than the default values, 

then change them according to your equipment requirements. 

 

The two boxes near the bottom of the above dialog box labeled “ADD TO” and MULTIPLY BY” 

allow you to adjust the raw numbers coming in from the Control Box .  You can add a constant 

value to each reading, or multiply each reading by a constant value.  These will normally be 

adjusted based on the type of control box you use, however change these values if you want. 

Click OK to close the setup screen.  Since GradePlane only accepts elevation readings less 

than 1000, in some case you must use these correction factors.  For example, if your control box 

outputs in hundredths, e.g. 8500.  You should “MULTIPLY BY”  0.01 to convert the value to 

85.00. 

 

Next, click on   the Start button which turns on the Port and starts collecting data from your 

survey mast. 

 

You should see the latest reading from your control box in the Laser box: 

 

 
 

Now you can start collecting data.  Drive to the proper grid station and press the RETURN key 

on your keyboard to enter the Mast Elevation data into the spreadsheet. 

 

Each time you press RETURN, the mast data will be entered and your cursor will advance to the 

next cell. 

 

The auto advance button will automatically advance left to right  (LR) 

to start . But, by clicking on the button, you can change the auto 

advance direction to right to left  (RL),  up to down (UD), or down to 
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Up  (DU)  Each time you click on the button it will toggle to the next value.  So, if you get out of 

sync, just keep pressing the button until you get to the direction you want. 

 

  

 

 

GradePlane is set up to make surveying in any direction fairly easy using the Mast.  Once 

you get started surveying, when you get to the end of a row or column press either the + key or 

the  * key on the numeric keypad and the cursor will advance to a new row or column and the 

auto advance direction will reverse allowing you to survey back the other direction. 

 

You can also reverse directions by pressing the New Row or New Col buttons if you want.  It is 

usually easier to use the keyboard. 

 

When you're done surveying with the Laser, press the STOP button to turn off the serial port and 

un-select "Survey with Laser Mast" from the options menu. 

 

Laser Survey Adjustment - Surveying using a Laser with Slope 
 

In some situations, a field may have such large slope changes from one side to other that you may 

want to survey using a laser containing slope to obtain all survey readings with one laser setup.  

GradePlane can correct data surveyed this way and convert to the actual elevations.  In order 

to do this, you will need to specify the laser slopes and a reference station for the Laser location.  

Gradeplane will then add or subtract the appropriate slope values from the measured values 

depending on the location within the field.  This will be a one time conversion to modify the raw 

data.  After loading or importing your raw uncorrected field survey data, Select Laser Survey 

Adjustment from the Options Menu.  This brings up a dialog 

box where you enter the Row and Column slopes and the 

Laser Reference Station.  The Laser Reference station is 

simply the station location that will have 0 adjustment.  After 

entering these values, click  “OK.”  All the survey data values 

will be corrected and the design will recalculate.  You should 

then save the field data under a different name. 

 

If you happen to make an error when entering slopes, the only 

way to recover is to again select the Laser Survey 

Adjustment and enter the opposite values to un-correct the 

data.  For example, if you entered a row slope of .10 and it 

was incorrect.  Select the item again and enter -.10 as the 

slope. This returns the values to the way they were.  Another 

option is to re-load the raw uncorrected data and start over. 

 

 

 

Volume Calculations 
 

The overall objective with land grading is to grade a particular field to a designed plane with the 

specified field row and cross slopes. The design plane is then compared to the existing field 

survey and either cut or fill values are specified for each grid location depending on whether the 

station is above or below the desired design plane.  Dirt is moved from cut stations to fill stations 
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to create the designed plane.  You also normally want the cut yardage to equal the fill yardage so 

that the field is balanced.  That is, you don‟t want to be short or long on dirt when you‟re done. 

 

GradePlane uses the specified grid interval and the amount of cut or fill at each station to 

determine the overall cut volume and fill volume. Gradeplane uses the summation method, where 

it is assumed that each grid section is flat, and the surveyed elevation is the elevation of the entire 

grid section. This assumption may not be true, so it is important that the elevation surveyed be 

representative of the entire grid elevation. For stations 100 feet by 100 feet, a one tenth cut or fill 

across the station represents about 37 cubic yards of earth moved.  (100 x 100 x 0.10) / 27 cubic 

feet. Usually, you want to have dirt “balance” across the entire field.  When a field is balanced, 

you have exactly the right amount of dirt moved.   

 

Due to soil shrinkage you need more cut volume than fill volume. In order to balance yardage you 

need to know and enter the ratio of a field‟s cut to fill.  Total yards cut, divided by Total yards 

filled is the Cut to Fill ratio. The Cut to Fill ratio you enter is only an estimate of the actual field 

cut to fill ratio.  Cut to fill ratios will always vary depending on the type of soil, moisture content, 

depth of cuts, and farming history. Normally cut to fill ratios are between 1.2 and 1.5 but they 

vary. If you grade in one area, you can normally determine a good starting point based on past 

experience. However, if your cut to fill ratio is incorrect, your yardage calculations may not be 

accurate and your field may not balance.  It is the land grader‟s responsibility to ensure that the 

cut to fill ratio is correct, and if not, make adjustments in setup during grading.  The grader must 

tally the cuts and fills as work progresses and adjust elevation up or down to insure balance. 

 

Using the specified slopes, GradePlane adjusts the design plane elevation up or down to achieve 

the desired cut to fill ratio.  Raising the plane reduces cut volume and increases the fill volume. 

Lowering the plane increases cuts and decreases fills. GradePlane defaults to a 1.25 Cut/Fill ratio 

which means you cut 125% of the required fill volume.  You can adjust the ratio, to any value, 

and you should use a ratio appropriate for the type of soil you are grading. 

 

 

Data Entry 
 

GradePlane defaults to elevations as the data type.  You can change this value to Rod 

Readings from the Options, Preferences Menu.   GradePlane remembers any settings you 

change in the Preferences menu and saves them as defaults.  Leave the data type set to elevations 

unless you know you have a survey in Rod Readings, or you prefer rod readings (and know how 

to get them) when conducting a survey. 

 

To begin a new field design, first specify the data type (rod readings or elevations) and field 

border distances (if not ½ the grid size), then begin entering your survey readings. If you specify 

the data type as Rod Readings, but enter elevations, everything will be backwards and 

calculations will be incorrect. Readings may be up to 999.99. GradePlane remembers the previous 

value entered so a previous reading value can be repeated simply be pressing the Enter Key.  As 

you enter data and press the enter key, you automatically advance to the next cell (from Left to 

Right.) You can change this to advance from right to left if you prefer. You change the direction 

by clicking on the  Auto L/R button just above the upper right hand corner of the Survey date 

entry spreadsheet.  At the end of each data line, pressing the „*‟ or the „+‟ key will advance to the 

next row and return you to column 1 in the spreadsheet.  
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Field Design 
 

 GradePlane will automatically calculate and display a “best fit” design based on the 

surveyed data.  When you enter or import your field data, the field design is created for you 

automatically using the calculated best fit slopes for the field.  

GradePlane calculates a least-squares best fit of the field using an 

average of the row and column elevation profiles.  The best fit 

will conform to the natural trend of the field slopes and be very 

close to the optimal design for moving minimum yardage. 

However, the best fit slopes are calculated values based on the 

average of each of the row and column slopes. Clicking on the 

“Use Best Fit Slopes” check box, sets the best fit slopes as the 

design slopes. You still may need to adjust slopes up or down 

slightly to obtain the slopes that will minimize the cut yardage. 

Gradeplane includes an option to automatically Minimize yards 

by incrementing the best fit slopes up and down slightly until 

values are found that minimizes the cut yardage.  You can also 

make slight adjustments up or down in your row or column 

slopes manually by clicking on the small  up or down arrows next 

the slope entry boxes.  If you press the Minimize Yards button 

GradePlane will try to minimize the best fit yardage by adjusting 

the slopes and then will set your design slopes to these calculated value. It then automatically un-

checks the checkbox.  Clicking it again will repeat the process.  Although this is a convenient 

feature, it also takes extra processing time, therefore you are required to select it manually.  Also, 

even though GradePlane attempts to minimize yardage, in some cases you still might be able to 

get a slightly lower yardage by adjusting the slopes up or down manually. 

 

 

Usually, you‟ll want to normalize the best fits slopes to standard values, for example, change .087 

to 0.10, but other than that, choosing the best fit design is the design for minimum construction.  

Of course, change the slope values to anything you want.  Experiment, and see how your 

adjustments change the total yardage.  The overall design is based on the original survey, the 

specified row and column slopes and the Cut/Fill ratio.  Changing any of these values affects the 

total yardage calculation. 

 

You can also specify to Import or Export yardage from the field.  If 

you need to obtain yardage to build a road or crown, you specify the 

amount as a design parameter. Likewise, if you have additional 

yardage you need to waste in a field, GradePlane can handle that also.  

Positive numbers designate import, and negative numbers indicate 

export.  Gradeplane considers import or export yardage when 

calculating the overall cut/fill ratio. 

 

 

You also can affect the field design by specifying the final elevation at 

a particular location.  For example, if you know you want the 

elevation at station E5 to be 44.50, you can force the elevation to be 

that value.  GradePlane will then use your specified Row and Column 

slopes to force the design to have an elevation of 44.50 at station E5.  

However, this will cause the Cut/Fill to move away from the specified 

1.25 to whatever is necessary to make the design work. You can 
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specify Row and Column slopes, and, either the Cut/Fill Ratio or the final elevation at a 

particular station, but not both. 

 

To specify a final elevation value, select the “final elevation” tab to view the final elevation 

spreadsheet. Use your cursor or mouse to go to a station and type in the final elevation you want.  
GradePlane 
recalculates the 

design to force the 

station to that 

elevation.  The 

cut/fill ratio will be 

adjusted to whatever 

is necessary to 

achieve the design. 

 

 

Defining Multiple 

Sectors 

 

In some cases you 

may find a particular 

field that has two or 

more well defined 

natural slope areas or 

sections as is the case 

in the field shown 

here. If you recognize 

this, and your final 

design criteria is not 

overly rigid, you can 

save a considerable amount in construction costs by specifying sectors in your field with different 

design parameters conforming closely to the natural shape of the field.  GradePlane not only 

allows you define multiple sectors, but also engineers the field so that at the hinge or breaklines, 

the field sections blend smoothly without abrupt elevation changes,  and  yardages balance across 

the entire field. Few other landgrading design programs can accomplish this. 

 

 

GradePlane can divide a field into multiple rectangular sectors (up to seven) and specify 

design parameters into each section separately. You can accomplish the same thing by dividing a 

large field into pieces and entering readings as separate fields. However, using sectors has the 

advantage of allowing you design the two sectors together and allow smooth transitions at the 

break lines. 

 

Each section can have its own Row and Column slopes, cut/fill ratio, and import/export yardage. 

Initially each section of the field will be a separate design plane and there could be significant 

differences in elevation at the break lines. By selecting Blend in either the Row or Column 

Direction, GradePlane will engineer the field planes so there is a smooth transition at the break 

points.  However, you can only blend in one direction at a time. For example, if you select blend 

in the Column direction, slopes will blend at break lines along the Rows. The Row slopes must 

be the same across both sectors for the blend to work. If you blend in the Column direction, 

GradePlane uses the Row slope in sector number 1 for the Row slope for all sectors. This works 

the same if you select Blend in the Column direction. 
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To define a sector, you first highlight the section of the field using your mouse. In the Survey 

screen move the mouse cursor to the upper left corner of the sector you want to define, hold down 

the left mouse button and drag across the stations until you reach the lower right hand corner of 

the sector.  Release the left mouse button and the sector will remain highlighted.  Now, click the 

right mouse button which will bring up a Pop-Up menu.  Select the Menu Item  Set Sector 

Slope…   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You should see the following dialog box. 

 

 

Enter your desired values. You can either click on the “Use Best Fit Slopes” button to accept the 

best fit slopes. Or, you can enter any slopes you want in the appropriate boxes. You can change 

any of these slopes later, so at this point you can enter anything you want. Click OK, when done. 

If you change your mind click cancel.  Repeat the above process to define additional sectors. 
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You can also “View Sector Info” from the Pop-Up menu instead of setting the slopes.  This item 

provides information about the sector defined, but doesn‟t allow to you enter slopes.  If you just 

want to check different sectors, then use this option. 

 

Here is the same field from above, the graphs show both a single plane design and a two sector 

design.  By conforming the design to the natural field contour with two sectors instead of using 

one plane, the total yardage moved is lowered considerably. 

 
 

 

 

If you want to delete sectors you can select  “Delete All Sectors” from the design menu.  Or 

while in the Survey spreadsheet, right click your mouse in the Sector you want to delete and 

select “Delete Sector.”  You must delete sectors in the reverse order that you created them. That 

is, you must delete sector 2, before you delete sector 1. 

 

 

 

Printing 
 

After completing your field design you will want to print your designs. GradePlane  has several 

different printing options where you can specify the printout desired.  You can print the old 

survey readings, a working map or Cutsheet, or a full map that lists old readings, new designed 

readings and the cuts and fills.  You can print more than one map by selecting the respective box 

in the print menu.  The print menu also allows you to print a page header with your business 

name, plus you can add a field name and customer name.  The page header entered will become 

the default and will print on future maps until you change it.  

 

 You can also print any of the 3-D graphs.  You print these from the 3-D view tab on the main 

screen.  Select the 3-D view you want printed, and click on the Print Graph button. 

 

Convert Data Type 
 

This option allows you to convert data from Rod Readings to Elevations or Vice Versa.  You 

must enter a bench mark or Instrument Height Value which will be used to convert the data.  This 

can be the actual instrument height or some arbitrary number.  GradePlane simply subtracts 

all survey readings from the specified number.  For example, if you have a 4.3 Rod Reading and 

specify 10 for the benchmark, the Elevation becomes  10 - 4.3 or 5.7.  If you entered data 

incorrectly and the data is really elevations and not rod readings (or vice versa) then simply 

specify the data correctly under the Preferences menu. Don‟t use convert data type. 

Single Plane -10,067 yds 2 Sectors  -  3,256 yds 

ydsPlane 
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Loading and Saving Field Data 
 

GradePlane uses standard windows menus for saving and loading field data files.  When 

saving GradePlane files the .fld  extension will be added to your field names.  For example,  

“myfield”  becomes  myfield.fld.  You can save the data whenever you want, plus you will be 

given the option to save data changed data before exiting. 

 

Import Data 
 

GradePlane can import data saved in from other data collectors.  Select File, Import Data… then 

select the appropriate file format. 

 

You can also Cut and Paste  readings from any spreadsheet type application.  For example, if 

someone provided you with field data entered into Excel, you load the file into Excel, then elect 

and copy the data from there and Paste the data into the GradePlane data entry screen. 

 

Keyboard  Navigation 

 

The following key combinations allow better navigation when entering field survey data. 

 

 

Home    Goto Current Row, Column A 

Ctrl Home Goto Cell A1 

*, +   Goto Row + 1  , Column A 

End  Goto Current Row, Last Column 

Delete  Delete Cell Contents 

 

 

3-D Graph 
 

GradePlane allows you 

to view and print 3 

dimensional graphic views 

of your survey readings and 

designs.  You view the 

graphs by selecting the 3D 

View tab. Graphs make it 

easier to visualize your field 

designs. For example, by 

looking at a graph of the 

survey readings you can 

better decide where you 

might divide a field into 

sectors.  

 

In the example below the 

surveyed field graph makes 

it easy to see a significant 

change in natural slope at 
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about Row 8.  In this case, you might choose to design the field in two sectors instead of one 

plane. 

 

From the 3D view window you can choose to view either the Survey Readings  or field Design by 

clicking on the button above the graph.  You can also print the selected graph by clicking on the 

Print Graph button. 

 

 

 

 

The 3D graph view is rotated from the 

way the data entry spreadsheet looks in 

order give a better perspective of the 

field. 
You can rotate or Zoom in on the 

graph view using your mouse.  To 

rotate the graph for a different view 

click and hold down your left mouse 

button while the cursor is over the 

graph. By dragging the mouse you 

can rotate the graph.  Likewise, if 

you hold down the right mouse 

button and drag, the graph gets larger 

or smaller depending on the direction 

you drag. 
 

Check Cut/Fill Ratio 
 

The Cut/Fill ratio entered into GradePlane is only an estimate.  If you estimate wrong, your field 

may not balance.  That is, you may end up with left over dirt when the field is completed or not 

have enough dirt for all of the required fills. In either case, this causes added time or expense in 

re-grading or rework to fix the problem.  You always want to end up with exactly the needed 

amount of cut and fill to make your earthwork balance.   

 

In order to do this, the land grader must continually check work progress to figure out whether the 

field is "going long" or "going short"  and make small grade adjustments to compensate.  

GradePlane provides tools to help you do this. On the printed Cutsheet, the cuts and fills for each 

row and column are listed.  By adding up the cuts and fills for the portion of the field already 

completed, the grader can determine  if the field is going long or short and then raise or lower 

setup elevation to compensate. 

 

 GradePlane also does this automatically and tells you the estimated amount to raise or lower 

elevation. This is another feature no other design programs offer. The Check Cut/Fill Ratio 

option does this for you.  In order to use this option, you first must select the Cutsheet Tab and be 

viewing the Cutsheet on your Computer Screen.  You then use the mouse to Highlight the stations 

already graded.  If you have completed a square area, you simply press the left mouse button and 

drag the cursor across the cells to select.  If you don't have a square area completed, you add 

individual cells to the selection by holding down the Ctrl key, then pressing the left mouse button 

while the cursor is over the cell you want to add.  After the cells are selected a button will show in 

the upper right hand corner of the spreadsheet.  Click on this button to check the ratio,  (You can 

also do this by pressing the right mouse button to bring up the pop-up menu, or select this option 
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from the Main Menu - Design 

item.)  In any case, GradePlane 

calculates the actual cut/fill ratio of 

the stations already completed, and 

gives an estimate of how far you 

should raise or lower the elevation 

to adjust for the real Cut/Fill ratio. 

 

As example, if your field designed 

cut/fill ratio was 1.25 and after 

completing a third of the field you 

check the real Cut/Fill ratio find it 

is 1.50 your design is not cutting 

enough to balance.  If you don't 

change your setup, the field will 

come up short.  What you should 

do is lower the setup elevation by a 

few hundredths of foot to increase 

your cut/fill ratio.  By continuing to 

check cut/fill and making 

adjustments the land grader can 

assure the grade is correct and the 

field balances. 

 

In the Cutsheet above we have highlighted an area that we have completed grading and clicked on 

the Check Cut/Fill Ratio button.  The dialog box informs us that the actual cut/fill ratio for the 

graded area is 2.17.  In this case our estimated ratio was 2.00, so we need to lower the field 

elevation by .02 feet since we are actually cutting more than we first estimated and we need to do 

the same on the rest of the field. 

 

 

For this feature to work properly, you need to use it very soon after the field work begins.  If you 

wait until the field is almost done, you might not have enough remaining work to make the cut 

adjustment and still smooth the field. Anytime the adjustment estimates are more than a tenth  

(.10) you probably have waited too long to make adjustments and will have to regrade portions of 

the entire field.  

 

What this option does is takes the stations you have completed and balanced, and calculates the 

actual cut to fill ratio. It then removes those stations from the field and recalculates the design 

using the actual cut to fill ratio. Finally it compares the elevation of the remaining stations to the 

original design elevations and estimates the amount you need to raise or lower the elevation.  This 

feature is another tool, and won‟t replace land grading experience. You can do the same thing and 

create a new cutsheet by deleting all the stations completed from your survey and change the cut 

to fill ratio to the new estimate.   

 

 

Installation 
 

In you received GradePlane on a CD ROM, it should automatically start and give you an 

installation menu when you place the CD Rom in your computer.   If it does not, to install 

GradePlane  you simply run the program GPsetup.exe  from the program disk provided or from 

the folder where you downloaded this file.  If you know where the file is located on your hard 
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drive (CD Rom or floppy disk), Double click on the file name from Windows Explorer, or Run 

the file from the Start, Run option on the start Menu.  Follow the prompts on the screen for 

installation.  GradePlane will normally be installed in the c:\program files\GradePlane  

directory. 

 

You can only install GradePlane on one Computer.  After installing it will only fully function 

for 30 days.  To complete the installation process after installing GradePlane, you must obtain a 

final Release Code by e-mail or mail to permanently authorize the program on your Computer . 

 

To get your release code, first start GradePlane.  From the Main Screen click the Help  menu 

item.  Then click on Install.  You will see a box similar to the following: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Copy the machine ID number.  In the above example, the machine ID number  is  1011799874.  

Send your Machine ID number by e-mail to support@Gradeplane.com  or to your dealer and 

request a final release code.  You will then be sent a release code similar to  A123 A123 A123 

A123  Open the Help Menu and click on Install option to again see the above dialog box. Enter 

the release code in the second box above and click OK.   GradePlane will then be completely 

install and won‟t expire. Record and save your release code.  Once installed, the Install option 

will disappear. 

 

You are only authorized to use GradePlane on one Computer. 

 

Entering a New Release Code 
 

In some situations you may need to enter a new release code.  For example, if your release code 

has expired,  you will need to enter a new code to continuing using GradePlane.  After you obtain 

the new code by e-mail, open the Help Menu and click on the About… menu item. 

 

You should see the following: 

 

 

 

mailto:support@Gradeplane.com
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Click on the New Code button which will bring up the Final Install dialog and allow you to enter 

the new release code.  Click Ok. 

 

 

Questions/Support 
 

If you have questions or problems contact your dealer or contact us by E-Mail at 

support@gradeplane.com 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

mailto:support@gradeplane.com
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Enter desired row and 

column slopes and 

Cut to fill ratios 

Select Tabs to display 

Cutsheet or Full Data 

Shows graph of Row 

and Column Profiles 
Select this box 

to use best fit 

values in design 

Click to change 

Auto Advance  

Direction. 

Shows best fit 

values and 

average 

elevation Totals Cut/Fill yardage 

when using multiple sectors 

Main Menu 
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Auto calculates a new 

field design every time 

any data is changed.  

Turn this off with very 

large fields to speed data 

entry. 

Adjusts survey readings IF 

survey was made using a 

laser with slope added.  

This subtracts out the laser 

slope based on the location 

of the laser. 

Convert from Elevations to Rod 

Readings or vice versa.  Enter a 

benchmark value, then all readings will 

be subtracted from this value to convert. 

Enter grid interval 

Specify Feet/Acres or 

Meters/Hectares 

Specify Elevations 

or Rod Readings 

Options Menu Items 
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If designed with 

multiple slopes these 

tabs show sector  

design values. 

Selecting blend, 

engineers smooth 

transitions at break 

lines 

Sector Slopes and Blending 

Sectors are outlined 

on on all screens 
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Pressing the Right mouse 

button brings up this „Pop-

Up‟ menu used to set, 

view and delete sector 

slopes.  (Not available in 

the lite Version 

Highlight a section of the field 

using the left Mouse button then 

press the right mouse button to 

bring up the Pop Up Menu.  Then 

select View or Set Sector Info.  

(Only in the Standard Cutsheet 

Version.) 

Pop Up Menu Items 


